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CF/X SOFTWARE END USER LICENSE AGREEMENT (EULA)

1. LICENSE GRANT

THE SOFTWARE IS LICENSED TO YOU EITHER AS A FULL VERSION (THE "FULL
VERSION") OR A RESTRICTED VERSION (THE "RESTRICTED VERSION").

CF/X AG, ZURICH (THE "LICENSOR") HEREBY GRANTS TO YOU A NON-
EXCLUSIVE AND NON-TRANSFERABLE LICENSE TO INSTALL AND USE THE
SOFTWARE AND RELATED DOCUMENTATION (THE "DOCUMENTATION") SOLELY
FOR THE INTENDED PURPOSES OF THE SOFTWARE AS SET FORTH IN THE
DOCUMENTATION ACCORDING TO THE PROVISIONS CONTAINED HEREIN. THE
INSTALLATION AND USE OF A FULL VERSION OF THE SOFTWARE IS SUBJECT
TO PAYMENT OF AN APPLICABLE LICENSE FEE AS INDICATED IN ARTICLE 2
BELOW (THE "LICENSE FEE").

YOU ARE NOT PERMITTED TO LEASE, RENT, DISTRIBUTE OR SUBLICENSE THE
SOFTWARE OR ANY RIGHTS THEREIN. YOU ALSO MAY NOT USE THE
SOFTWARE IN A TIME-SHARING ARRANGEMENT OR IN ANY OTHER
UNAUTHORIZED MANNER. MOREOVER, NO LICENSE IS GRANTED TO YOU
CONCERNING THE HUMAN READABLE CODE OF THE SOFTWARE (SOURCE
CODE). EXCEPT AS PROVIDED EXPLICITLY IN THIS EULA, THIS EULA DOES NOT
GRANT TO YOU ANY RIGHTS TO PATENTS, COPYRIGHTS, TRADE SECRETS,
TRADEMARKS, OR ANY OTHER RIGHTS IN THE SOFTWARE AND
DOCUMENTATION. THIS EULA DOES NOT ENTITLE YOU TO RECEIVE ANY
UPGRADES TO OR NEWER VERSIONS OF THE SOFTWARE.

YOU AGREE NOT TO MODIFY, TRANSLATE, REVERSE ENGINEER, DECOMPILE,
DISASSEMBLE, OR CREATE DERIVATIVE WORKS OF THE SOFTWARE OR ASSIST
SOMEONE IN PERFORMING SUCH PROHIBITED ACTS.

YOU ARE NOT ALLOWED TO REMOVE OR ALTER THE RESTRICTIONS PLACED
UPON THE RESTRICTED VERSION OF THE SOFTWARE. MOREOVER, YOU ARE
NOT ALLOWED TO USE A LICENSING/REGISTRATION KEY UNLESS YOU PAID
THE LICENSE FEE ACCORDING TO THIS EULA.

YOU MAY INSTALL AND USE A FULL VERSION OF THE SOFTWARE SUBJECT TO
THE TERMS AND CONDITIONS OF THIS EULA ON ONE CPU ONLY. IF YOU WISH
TO INSTALL AND USE THE FULL VERSION OF THE SOFTWARE ON DIFFERENT
CPUS, YOU HAVE TO PAY A SEPARATE LICENSE FEE FOR EACH USER.
UNLESS EXPLICITLY STATED IN WRITING, LICENSOR DOES NOT GRANT
PERMISSION TO DISTRIBUTE THE SOFTWARE FOR PROFIT IN ANY FORM,
INCLUDING, BUT NOT LIMITED TO, ELECTRONIC INFORMATION SERVICE
DISTRIBUTION, BULLETIN BOARD DISTRIBUTION, AND MAGNETIC OR OPTICAL
MEDIUM DISTRIBUTION. NON-PROFIT DISTRIBUTION OF THE SOFTWARE IS
ACCEPTABLE WITHOUT PRIOR WRITTEN NOTICE, PROVIDED THAT THE
SOFTWARE IS NOT MODIFIED IN ANY WAY, AND THE COMPLETE WORKS OF
THE SOFTWARE ARE INCLUDED IN THE DISTRIBUTION PACKAGE.



2. LICENSE FEE

FOR A FULL VERSION OF THE SOFTWARE, YOU SHALL PAY THE LICENSE FEE
INDICATED UNDER THE WEBSITE “WWW.CFXSOFTWARE.COM” OF THE
LICENSOR. THE LICENSE FEE SHALL BE DUE UPON PURCHASE OF THE
LICENSE. YOU WILL BE PROVIDED WITH A LICENSE FOR THE FULL VERSION OF
THE SOFTWARE ONLY AFTER YOU HAVE PAID THE LICENSE FEE TO THE
LICENSOR.

THE LICENCE FEE SHALL INCLUDE THE VALUE ADDED TAXES. ANY OTHER
TAXES SHALL BE PAID BY YOU. YOU SHALL BE RESPONSIBLE FOR, AND TO THE
EXTENT NECESSARY, SHALL INDEMNIFY LICENSOR AND ITS AFFILIATES FROM
AND AGAINST, COLLECTING AND REMITTING TO THE APPROPRIATE TAXING
AUTHORITIES ALL SALES, USE AND OTHER TAXES THAT ARE DUE AND
PAYABLE IN CONNECTION WITH THIS EULA AND THE LICENSING OF THE
SOFTWARE.

3. NO MAINTENANCE OR ENHANCEMENT OF THE SOFTWARE

YOU ACKNOWLEDGE THAT YOU WILL BE PROVIDED WITH THE SOFTWARE AND
THE DOCUMENTATION UNDER THE TERMS AND CONDITIONS OF THIS EULA "AS
IS", AND LICENSOR IS UNDER NO CIRCUMSTANCES OBLIGED TO MAINTAIN OR
ENHANCE THE SOFTWARE.

4. TITLE

YOU AGREE THAT LICENSOR OWNS AND HOLDS TITLE TO THE SOFTWARE, THE
DOCUMENTATION, ALL CONTENT THEREIN AND ALL SUBSEQUENT COPIES
THEREOF REGARDLESS OF THE FORM OR MEDIA. FURTHERMORE, TITLE,
OWNERSHIP RIGHTS, AND INTELLECTUAL PROPERTY RIGHTS IN THE
SOFTWARE AND THE DOCUMENTATION AND CONTENT THEREIN SHALL REMAIN
WITH LICENSOR. THE SOFTWARE AND THE DOCUMENTATION ARE PROTECTED
BY APPLICABLE COPYRIGHT LAWS.

5. NO WARRANTIES

THE LICENSE GRANTED IN THIS EULA, THE SOFTWARE AND THE
DOCUMENTATION ARE PROVIDED "AS IS" WITH ALL FAULTS AND WITHOUT ANY
WARRANTIES. LICENSOR HEREBY DISCLAIMS ALL WARRANTIES RELATING TO
THE SOFTWARE AND DOCUMENTATION, WHETHER EXPRESSED OR IMPLIED,
INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. LICENSOR IS
NOT RESPONSIBLE FOR ANY DAMAGE TO YOUR COMPUTER SYSTEM OR DATA.
TO THE FULL EXTENT PERMITTED BY LAW, THE STATUTORILY WARRANTIES, IF
ANY, SHALL BE EXCLUDED OR LIMITED.



6. LIABILITY AND INDEMNIFICATION

ANY AND ALL LIABILITY OF LICENSOR, ITS OFFICERS, DIRECTORS, EMPLOYEES,
REPRESENTATIVES AND AGENTS, INCLUDING BUT NOT LIMITED TO LIABILITY
FOR ANY DIRECT, CONSEQUENTIAL, INCIDENTAL, IMPLIED OR INDIRECT
DAMAGES SUCH AS DAMAGES ARISING OUT OF OR CONNECTED WITH THE USE
OR INABILITY TO USE THE SOFTWARE AND THE DOCUMENTATION IS
EXCLUDED TO THE EXTENT LEGALLY POSSIBLE. INDIRECT DAMAGES IN THE
SENSE OF THIS PROVISION SHALL INCLUDE BUT NOT BE LIMITED TO LOSS OF
BUSINESS PROFITS, BUSINESS INTERRUPTION, AND LOSS OF BUSINESS
INFORMATION.

YOU AGREE TO DEFEND, INDEMNIFY AND HOLD HARMLESS LICENSOR, ITS
SUPPLIERS AND ITS RESELLERS FROM AND AGAINST ALL LIABILITIES, COSTS,
DAMAGES AND EXPENSES (INCLUDING SETTLEMENT COSTS AND REASONABLE
ATTORNEYS' FEES) ARISING FROM ANY CLAIMS FROM ANYBODY THAT RESULT
FROM OR RELATE TO YOUR INSTALLATION, USE, REPRODUCTION OR
DISTRIBUTION OF THE SOFTWARE OR YOUR BREACH OF ANY
REPRESENTATION, WARRANTY OR OBLIGATION UNDER THIS EULA.

7. TERM AND TERMINATION

THE LICENSE GRANTED UNDER THIS EULA WILL BE PERPETUAL FROM THE
DATE THAT YOU FIRST USE THE SOFTWARE, IF IT IS NOT EARLIER
TERMINATED. YOU MAY TERMINATE THIS LICENSE AT ANY TIME BY
DESTROYING THE SOFTWARE AND ANY DOCUMENTATION TOGETHER WITH
ALL COPIES THEREOF. THIS LICENSE WILL ALSO TERMINATE IMMEDIATELY IF
YOU FAIL TO COMPLY WITH ANY TERM OR CONDITION OF THIS EULA. UPON
SUCH TERMINATION, YOU AGREE TO DESTROY THE SOFTWARE AND
DOCUMENTATION, TOGETHER WITH ALL COPIES THEREOF. YOU AGREE NOT
TO BE ENTITLED TO A REFUND OF ANY LICENSE FEE, IF ANY, UPON EARLY
TERMINATION OF THIS EULA.

8. MISCELLANEOUS

EXCEPT AS OTHERWISE PROVIDED IN THIS EULA, YOU AGREE THAT IN THE
EVENT OF ANY DISPUTED OR UNRESOLVED CLAIM, DEBT OR OBLIGATION, ANY
AND ALL RIGHTS TO SETOFF AND/OR RIGHTS TO RETAIN FUNDS ARE
EXPRESSLY WAIVED.

YOU AGREE NOT TO TRANSFER OR ASSIGN THE SOFTWARE AND/OR THIS EULA
TO ANOTHER PARTY WITHOUT THE PRIOR WRITTEN CONSENT OF LICENSOR. IF
SUCH CONSENT IS GIVEN AND YOU TRANSFER OR ASSIGN THE SOFTWARE
AND/OR THIS EULA, THEN YOU MUST AT THE SAME TIME EITHER TRANSFER
ANY COPIES OF THE SOFTWARE AND DOCUMENTATION TO THE SAME PARTY



OR DESTROY OR RETURN TO LICENSOR ANY SUCH MATERIALS NOT
TRANSFERRED. EXCEPT AS SET FORTH ABOVE, YOU MAY NOT TRANSFER OR
ASSIGN THE SOFTWARE OR RIGHTS UNDER THIS EULA.

THIS EULA CONSTITUTES THE ENTIRE AGREEMENT BETWEEN YOU AND THE
LICENSOR (THE "PARTIES") AS TO THE SUBJECT MATTER HEREOF.

SHOULD ANY PROVISION OF THIS EULA BE INVALID OR UNENFORCEABLE, THE
REMAINING PROVISIONS SHALL BE VALID. IN THE PLACE OF AN INVALID
PROVISION, A VALID PROVISION IS PRESUMED TO BE AGREED UPON BY THE
PARTIES, WHICH COMES ECONOMICALLY CLOSEST TO THE ONE ACTUALLY
AGREED UPON.

ALL DISPUTES ARISING OUT OF OR IN CONNECTION WITH THIS EULA SHALL BE
GOVERNED BY MATERIAL SWISS LAW EXCLUDING THE CONFLICT OF LAW
RULES AND THE LAWS IN TREATIES INCLUDING BUT NOT LIMITED TO THE
UNIFORM LAW ON PURCHASES (VIENNA TREATY).

9. COMPANY INFORMATION
FOR ANY QUESTION CONCERNING THIS EULA OR THE SOFTWARE, PLEASE
WRITE TO:

INTERNET:
EMAIL: INFO@CFXSOFTWARE.COM
WEB: HTTP://WWW.CFXSOFTWARE.COM

STANDARD POST SERVICE

CF/X AG
WINKELRIEDSTRASSE 1
CH-8006 ZURICH
SWITZERLAND



Welcome to cf/x photo

Thank you for choosing cf/x photo! We hope that you enjoy using this app, and that it
gives you as much joy and fun as it gives us. This document will give you an overview of
cf/x photo’s most important features and how to use them.

About cf/x photo

Photography has undergone a tremendous change in the past two decades. Invented
around 1820, for 100 years it largely remained in the domain of professionals. With the
invention of standardized photographic films and mechanized development processes, it
appealed to many more people. Photography reached the true turning point, however,
with the advent of digital consumer cameras in 1995. The advantages of digital
photography (from an end-user’s perspective) quickly turned that whole market around.
In 2000, film-based cameras still outsold their digital brethren, but only 9 years later, in
2009 sales of photographic film had dropped to levels that most manufacturer stopped
producing them.

Digital photography has great impact on the way we use and view photographs. Today,
shooting a picture costs next to nothing, and as a consequence we have lots, and lots of
them. We all use photo management software (iPhoto/Aperture) to get a handle on our
steadily growing mountain of images. But with a growing image collection comes a new
challenge: photo management software is great at retrieving images for you. But your
images, great in numbers as they are, remain diamonds in the rough.

And here is where cf/x photo comes in: it has a simple user-friendly user interface that
guides you through the process of polishing up your photos and perfecting them.

cf/x photo provides you with

- An easy to use, non-destructive, non-linear workflow environment

- A professional cropping environment (with integrated aspect- and output
management), complete with alignment- and composition tools such as rules of
thirds, diagonals, and Fibonacci Golden Rule

- An array of image touch-up tools to control color and brightness

- Special image processors like LOMO/HOLGA’, ‘Tilt-Shift-Lens’ and many more

- Professional image f/x to produce studio-level image finish

- Anintegrated manager that allows you put a beautiful frame around the picture

- A Text layer that allows you to place any text over the image

- A copyright manager that allows you to place your logo and/or copyright message
anywhere on the image — at any size

- A transparency/blend manager that controls the transparency of the finished
picture.



For advanced and professional users, cf/x photo also provides a ‘Factory’ mode where
all your settings can be automatically applied to a bunch of photos (in what geeks call a
‘batch mode’).

The Factory will be part of a later release, and requires a separate purchase of that
functionality (as In-App Purchase via the Mac App Store, or secure internet purchase
from our web page).

About cf/x photo’s sister application

We have another, simplified application ‘photo crop’ available. Even more focused than
‘cf/x photo’, that application gives you access to the first worktable: crop. All other
functionality (including Factory), has been eliminated to provide you with a single-
purpose, easy-to-use high-performance cropping tool. cf/x photo crop and cf/x photo
share a common ancestor: cf/x alpha, which provides the strong image manipulation
core used in both apps.

About the cf/x photo icon

Photography enthusiasts instantly recognize the iconic Rollei 35 film camera that we
based our app’s icon on. It’s a mid-1970s Rollei 35S, in black, that we proudly call our
own. We photographed this beautiful mechanical wonder using a whitebox and two
studio flashes arranged at 90° with a 100mm macro lens at /13.

The resulting image was cropped and filtered using a pre-release version of cf/x photo.
Final processing and mastering was done using cf/x alpha.



About This Document

This document teaches you how to use cf/x photo. Although you'll find that you can
easily use cf/x photo without reading this manual, we strongly recommend you read it if
you want to get the most out of the application.

Document Conventions

Throughout this document you will find call-outs that contain important information.
Please look for the following:

An exclamation mark denotes a paragraph that contains important information that you
may want to remember when working with cf/x photo.

A paragraph with the ellipsis symbol next to it holds some interesting information that
may help you understand how a feature works, or how it interacts with other features.




Installation And Registration

System Requirements
In order to run cf/x photo you need at least the following:

- Any Intel-based Macintosh

- 2 GB of memory (4 GB recommended)

- 0OSX 10.6 or above

- A monitor with at least 1024x768x32 resolution

- Internet connection for automatic update notification and registration

Installing cf/x photo
Simply drag the cf/x photo icon to your ‘Applications’ folder.

If you purchased cf/x photo from the Apple Store, the app is already installed, and
registered to you. You do not have to install it yourself.

Registering cf/x photo

If you purchased cf/x photo from the Apple Store, it is already registered to you.

When you install and start up cf/x photo for the first time, it switches into ‘DEMO’ mode.
In Demo mode the application functions exactly as when licensed - except that any
export is watermarked ‘DEMO’. Once you purchase a license (i.e. ‘registering’ it), cf/x
photo switches into production mode, and no longer applies the watermark to
subsequent exports.

A license can be purchased on-line within seconds with the ‘Purchase License’
command from the ‘Special’ menu. Once you have successfully purchased a license on-
line, cf/x photo immediately switches into production mode. Purchasing a license on-line



requires that your Mac be connected to the Internet. Licenses can also be purchased off-
line from cf/x.

You can also enter a license key manually from the ‘Enter License’ command. cf/x photo
then switches into production mode.

Internet Update Notification

cf/x photo can check to see if a newer version is available for download. This feature is
activated manually. cf/x photo then connects to the Internet, and retrieves current
version information from cf/x. No information about you or your Mac is transferred to cf/x
during this process.

If you purchased cf/x photo from the Apple Store, the Store notifies you of any updates.
Due to Apple Store restrictions, photo does not check for updates and does not provide
a ‘check for update’ menu item.




Introduction

People born before this millennium may recall that before the advent of digital
photography, a lot of effort went into creating beautiful images: first you had to ‘develop’
the film (which turned into ‘negatives’). Then you used an especially evil dungeon called
‘darkroom’, filled with expensive optical equipment and dangerous chemicals to turn
these negatives into photos. In the darkroom you cropped the image and tried to use the
properties of photographic paper and chemicals to make the resulting image look better.
This was a process of low tech and high art (and health hazard), as few people could
predict how a particular image would look before they actually tried it.

When digital photography arrived, all this changed. No longer were you required to
complete a roll of film before you could develop it. Images simply appeared mere
seconds after they were shot. No negatives, no development, just sheer fun.

As a result, photography has completely become mainstream, with digital cameras
readily available to everyone.

The one (perhaps only) drawback of this development' is that the art of cropping and
polishing images has almost been forgotten. Professional photographers of course still
practice it. But almost anyone else simply shoots their pictures, archives them in photo
management software, and occasionally shares a particularly good one. Your mountain
of photos contains many diamonds in the rough that will never see the light of day.

And this is really, really sad. Because many of the pictures you think are just mediocre
really are beautiful — once cropped and touched up with a simple filter.

That is the reason we built cf/x photo. You can get so much more out of your images
with very little effort — if you have the right tool. cf/x photo is that tool.

cf/x photo Worktables

cf/x photo is modeled loosely on the old-school photo development process. It works by
separating the different steps that go into polishing an image into a small number of
easy ‘stages’. Imagine a room with a number of dedicated worktables, one for each
stage. cf/x photo doesn’t require you to go to these tables in any particular order, and
you can re-visit any table at any time. Everything you do in cf/x photo is completely non-
destructive, so you can experiment to your heart’s desire.
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Figure 1 : cf/x photo’s worktables:
crop, effects, frame, text, copyright, blend (, Factory)

' We were dying to make this pun.



Each of these tables has their own focus, and you seldom use all tabels for an image.
For example, you’ll usually skip the ‘Copyright Notice’ worktable unless you are a
professional or want to make sure you get the credit you deserve for your photo. Still, it’s
just nice to know that it’s there in case you need it.

There are six worktables in cf/x photo:
- Crop
- Effects/Color Correction
- Frame
- Text
- Copyright/Watermark
- Transparency

Before we go into the details of how to actually use them, let us briefly look at what they
are for.

Crop

Here is where you create a good picture out of a normal one. There’s beauty in every
picture — you just have to find it. The secret of all successful photographers is that they
have an eye for finding beauty in an image, compose it, and discard (crop) the rest. You
can easily do the same once you understand the fundamentals (see the ‘Crop’ sections)
and have the tools (you do now). Smartly cropping an image usually has the greatest
impact on your image, so make sure you master this table first.

Effects/Color Correction

This worktable has two uses. You can use it to enhance your photo’s color, brightness,
saturation, or color space usage. Photographers use this to ensure that all photos in a
run have the same color tone (i.e. make it obvious that they belong to the same run),
and to correct for small color aberrations caused by lighting. cf/x photo has a range of
color correction and optimization tools that allow you to interactively adjust the color
fidelity of your picture.

The other use, of course, is that you can radically alter colors, brightness differences,
texture, or even appearance of the whole photo to create unique artwork. cf/x photo has
a number of incredible special effects that makes creating your own look fun and easy.

Frame

Some images greatly profit from a frame — be it to bring out a contrast, or to better
delineate if from the background (especially in web pages). cf/x photo has a worktable to
do just that-with a few, very simple controls. Don’t worry about elaborate frames, though.



We know that you don’t want to distract from your image so you’ll only find tasteful
frames in this app®.

Text

On this table you can add text to your image. Any text. Any font. Any color. Mix as you
please. Oh, and with controllable transparency too. And full justification control.

We hope you never need it. Text is boring. Unless it comes in the form of a manual.

Copyright

This is something we know professionals would Kill for (unless they use cf/x alpha). This
worktable allows you to effortlessly place an image (usually a logo, with full support for
transparency) and one line of text (set in ‘Helvetica’) anywhere on the image. You have
full control over transparency, size and color.

Transparency

The final worktable is something only very few real-life darkrooms had: the ability to
make parts of your image transparent. Even after photography has gone digital, few
photo packages allow you to do this. Which we think is a major oversight. Web
designers especially will appreciate this feature.

Since we designed cf/x photo to vaguely resemble a work flow, we built in a ‘natural’
order of progress: each ‘Table’ shows the combined results of the previous tables, but
none of the later ones (e.g. if you are working at the text table, you see the results of the
crop, f/x and frame worktables, but none of the tables that come ‘later’: copyright or
blend — even if you have worked on them already).

You might have noticed another worktable, the factory. This table will become available
soon, but requires an In-App Purchase to enable. The factory allows you to apply all
your current settings to a large number of images automatically. This feature is only of
interest to high-end users.

2 We are serious about that. At least until we find a beautiful elaborate frame that doesn’t look like a
pimped-up faux-wood picket fence fercryingoutloud!



Using cf/x photo

cf/x photo is loosely modeled on a normal® photo polish workflow. It usually goes as
follows:

- you bring a photo (‘Import’)

- you walk with the image to the various work tables until it is perfect

- you deliver the finished photo (‘Export’)

The real work happens at the worktables, and this is what we’ll focus on in this manual.
Still, cf/x photo has strong image import and -export capabilities, so we’ll briefly touch
upon those areas as well. One particularly nice fact about this app is that you can rapidly
apply all current settings to many images — simply by using one of the import methods
(usually drag & drop) and then immediately exporting the result (this is low-tech version
of the ‘Factory’).

cf/x photo main window

cf/x photo is built on a ‘one image per window’ workflow. Whenever you open a new
window, it can contain only one image at any time.

Any window can act as a ‘drop zone’ for images you want to work on. If you drop more
than one image into a window, cf/x photo automatically opens additional windows, one
for every image dropped. The app automatically stacks all new windows to allow you to
quickly work though them one by one.

If you have just started up photo crop, you’ll see one big empty window with the not-so-
subtle hint to ‘Drop Images Here™. That is where the easiest import method (drag &
drop) expects you to dump an image to work on. Of course, there are many other ways
to import images, which we’ll discuss right after this.

® We use this term with some artistic license.
* Please also note our even more subtle (in a ‘wink, wink, nudge, nudge, say-no-more’ kind of way)
company logo placed discreetly behind the ‘Drop Images Here’ hint.
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Figure 2 : cf/x photo’s main window, crop table active, empty

Note that you can resize a window any time using the resize box in the lower right

corner.

You may notice a passing resemblance this window has with the main window of our

‘cf/x photo crop’ app. This is of course pure coincidence”.

Note the top of the window, which shows the tool bar that gives access to the various

‘work tables’,
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Photo Processing Worktable

as well as short cuts to some other often-used tools. At the lower right corner, note the
‘Crop Control’ caption. You can always tell at which table you are currently working by

looking at this text.

® Wink, wink, nudge, nudge...




Importing Images

There are many different ways to get images into cf/x photo, and the way you import
images largely depends on what you like most. By far the most efficient way is drag and
drop, but we’ll run through all of them:

Using ‘Import’ / Get Photo

The ‘old-skool’ way of opening images is to use ‘Get Photo’ from the tool bar,

or by choosing ‘Import Image’ (381) from the ‘File’ menu. cf/x photo then opens a
a File Navigation dialog. Once you have found your image it opens it in the

current window (or a new one if there is no window open).

Using the Media Browser

Using the media browser gives you access to special media groups such as ‘Events’,
‘Albums’, ‘Faces’ etc. that you may have defined in iPhoto or Aperture.

To access the Media Browser use ‘Get Photo’ on the tool bar, or choose ‘Import Image’
(381) from the ‘File’ menu. Now locate the left sidebar (the one that lists all your devices),
and scroll down until you reach the ‘MEDIA’ group (near the bottom). Next to the
‘MEDIA’ label you'll find a triangle. If the triangle is pointing to the right, click on it to
disclose the contents of the media group.

From the media group you have instant access to all your events, photos, faces, albums
etc. that you have defined in iPhoto.

OO0 Please choose Image(s) to import...
(«|») (23] =] m) [ Photos M Q
rﬁ Applications 7 iPhoto
[} Documents
B3 Movies (7] Photos
J3 music || Faces
(@] Pictures & Places
& cffx (1) Last Import A
SEARCH FOR ™ Last 12 Months ) v

(L) Today

() Yesterday

(L) Past Week

[E] All Images

All Movies

All Documents

MEDIA

ﬂ Music
@ rhotos
B Movies
New Folder ( Cancel ) Choose
( )

Figure 3 : Using the OSX Media Browser to access iPhoto’s Events



Note that cf/x photo supports drag and drop from the media browser, so you can either
double-click on the item you want to use, hit the ‘choose’ button, or drag the image
directly onto the window.

Using Drag & Drop

We believe that drag & drop integrates best into most workflows, and hope that this is /
will be your preferred way of importing photos. Simply grab the images you want to work
on (more than one at a time is supported, even folders), and drop them onto cf/x photo.
You can drop images into any open cf/x photo window, or onto the application’s dock
icon.

Advanced users please note that there is a subtle difference between dropping a single
image, and dropping two or more images: If you drop one image onto a window or the
dock, the image replaces the contents of the active window. If you drop more than one
image, the first image replaces the contents of the active window, while new windows
are opened for all other images.

As soon as cf/x photo receives the drop it opens new windows (if you dropped more
than one images), one for each image dropped.

Some applications (e.g. Aperture) can be set to export low-quality versions when you
use drag & drop. Make sure you verify the exporting app’s export quality.

cf/x photo also supports drag & drop from ‘un-sourced’ images, i.e. images that do not
have a source file. You can, for example, drag an image out of a browser window or any
app that fully supports dragging of image selections (e.g. ‘GraphicConverter’,
‘PowerPoint’, etc).

Using Copy/Paste

Of course cf/x photo fully supports copy/paste. Copy any image to the clipboard, and
paste it into an open window. Additionally, photo crop supports pasting files (images)
from the finder.

Pasting a graphic always replaces the contents of the front most window.

Supported File Formats

cf/x photo imports most common file formats, including ‘RAW’ from most camera
manufacturers, and PDF.



Handling Alpha/Transparency Information
Some file formats support embedded transparency (a.k.a. ‘alpha’) information (e.g. PNG,

PDF, TIFF). cf/x photo fully supports images with alpha, and combines the original’s
transparency with any transparency information you specify at the ‘Blend’ worktable.

Note that in order to take advantage of this, you must export to a file format that also
supports transparency.

EXIF and Geo-Tag Information

If your source image has EXIF (Exchangeable Image File Format) or Geo-tagging data
embedded, cf/x photo reads and preserves this information. If you then export such an
image, cf/x photo embeds this information to the exported image (if the chosen export
format supports EXIF® or Geo-tagging information ).

® At the point of writing, only JPEG and TIFF support EXIF; TIFF’s EXIF support is more limited than
JPEG’s.



Cropping Images
Cropping images is not only one of the most basic, but also most important tasks in

photography. A good image can become stunning when, through careful cropping,
uninteresting parts are dropped, and the remaining picture is re-composed to look

dramatically better.
)‘ !

Figure 4 : crop example: original (left), cropped and re-composed image (right).
Notice how cropping can dramatically improve the overall image
composition. Photo shot using an EOS 5D using a 24-105 mm lens

Modern digital cameras offer high pixel densities. Photographers can be less careful
when composing during a shoot - because they can re-crop the image in post
processing. Thus, the very basic art of cropping images has become more important
than ever.

Many modern photo management and -processing applications provide basic crop
features. As most professional photographers can attest, however, these functions are
at best rudimentary, and seem to be added as an afterthought. This is a problem
because, in our experience, cropping a photo can do more to the way your images look
(good or bad) than any other step (including color processing).

cf/x photo has an exceptionally strong crop table that makes high-precision cropping of
your photos a snap. The crop table is a direct descendant from our ‘cf/x photo crop’ tool,
one of the most advanced and highly regarded photo cropping tools in the market.



Using the Crop Worktable (overview)

The first worktable in cf/x photo is also the most important one: the crop table. Switch to
this table by clicking on the ‘crop’ icon on the worktable selector:
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Photo Processing Worktable

What you do here is simple: you define the area of the photo that you want to keep. All
other tables use only the part that you keep, and discard everything else. Everything at
this table is set up to make this process as quick and intuitive as possible.

The area surrounded by the cropping crosshairs (we love alliterations, sorry) is the
‘keep’ area. You control the size and position of that area as follows:

- to move, click into the inner part of the area, and then drag the mouse
- toresize, click and drag any of the eight ‘Handles’

Whenever you change the crop area, the crop table
updates the crop information in the upper right corner
of the Crop Control panel: o e 7oxt098
- Source: Size of the source image (never Aspect: 1.53 3:2, 14:9 - 35mm
changes)
- Crop: Size (in original pixels) of the crop area
- Aspect of the current crop. If the aspect is that of a common format (e.g. DIN Ax
in above example), the crop table displays that format’s name.

Image:

Simply move and resize the crop area until you have the perfect crop, then hit the
‘Return’ key to continue to the next table. You are done.

... except that cropping is so important that we filled this table to the brim with smart
functionality to help you get the best possible crop with the least amount of effort.

Let’s take a more detailed look at what the crop table has to offer you:



Composition Guides

Back in the days of film-based photography (when some of us here at cf/x shot our first
photos), an important part of shooting was to carefully compose each image before you
shoot. Composition was important because cropping during postproduction was
something to avoid: photo paper was expensive (it still is, but back then you needed one
piece of paper for each try). Worse, cropping invariably involved a smelly darkroom,
filled with dangerous chemicals, and expensive optical devices that broke whenever you
bumped against them in the darkness’.

Nowadays, digital image processing has eliminated the need for a darkroom, and ever-
increasing image resolutions allow us to discard large parts of an image. This has
enabled photographers to focus more on the moment, and less on the mechanics. Most
photographers still compose their shots, but can be much more lax about it. Composition
of most photos is now done during post processing.

That is why our crop worktable provides you with an array of composition guides that
help you compose your crop:

- Rule of Thirds
The most common (and easiest to understand) guide simply shows the lines that
run though 1/3 and 2/3 of the picture. Lining up prominent parts of the scene
(horizon, Nose, Eyes) with these lines usually makes the image look much more
pleasing. Note that the Rule of Third is a quick, workable approximation of the
‘Golden Ratio’ (see below), a more accurate approximation used by
professionals.

- Diagonals
You can use the dynamics of a scene to your advantage if you align naturally
occurring slanted lines (shore line, roof, outstretched arm) with one of the four
diagonals.

- Cross Hairs
‘+’ marks the spot. This ‘guide’ merely marks the center of the crop, useful when
you construct a crop around a certain point. The crosshairs show up in Diagonals
and Rule of Thirds as well.

- @Golden Ratio (Fibonacci Spiral)
A peculiar quirk of human sight is that (for reasons unknown) images that observe
the golden ratio seem to be much more pleasing than others. The above-
mentioned ‘Rule of Thirds’ is a workable approximation of the Golden Ratio, and

” Don’t get fooled by photo veterans that get all hazy-eyed as they recall how great working a darkroom
was way-back-when. They either had their assistants do it — or don’t know any better because the
chemicals did strange things to their brains.



is used in most modern viewfinders because of this. Golden Ratio is the
progressive sub-division of a scene in the ratio of 1:1.618... and always follows
the shape of a spiral. Professionals around the world love it because it can
enhance the impact of an already nicely composed image dramatically. It is not
universally used, though, because the Golden Ratio spirals are not as simple to
use as the ‘Rules of Thirds’.

- cf/x photo generates four different Golden
Ratio spirals using the Fibonacci
Approximation. When you engage Golden
Ratio, the crop table gives you access to four
additional buttons that control which quadrant
of your image the spiral focuses on.

- Off
The last guide isn’t really one. It simply switches off all guides.

Composition guide control is simple: click the
button in the ‘Guides’ tool for the guide type that
you need.




Aspect Control

Most non-professionals encounter photo cropping only when they want to cut down® a
photo in order to fit a certain format (usually a picture frame).

A picture frame defines an ‘aspect ratio’, i.e. the relationship between an image’s width
and its height. When you need to fit an image into such a frame, you must make it fit its
aspect. The crop table has presets for most common aspect ratios. Once locked in, it will
automatically restrain the crop area so that fits the chosen aspect.

Any

Square
7x10(2.75x 4 in)
9 x 13 (3.5 x5.25 in)
DIN Ax

10 x 13 (4 x 5.33 in)
10x15(4 x6in)

13 x 18 (5x 7in)

13 x19(5x 7.5in)
18 x 24

20 x 30 (8 x 12)

30 x 45 (12 x 18)
iPhone

iPod Touch

HD (16:9)

TV, DVD (4 :3)
Absolute Size (fixed)
Custom

Defined by Output Size

Figure 5 : aspect presets

All presets except ‘Any’ restrict resizing the crop in one way or another. You bring up the
crop presets by clicking on the ‘Aspect Ratio’ pop-up menu. Simply choose the aspect

Using the Aspect Ratio Controls

Quite a lot on engineering and experience has
gone into the design of this little gem. Photo’s

Aspect Ratio control is the heart of all cropping
operations, and you’ll soon find yourself W: H:

enjoying the way the crop table almost @ Turn Aspect by 90°
anticipates what you want to do. The Aspect
Ratio controls consist of three simple elements: A preset pop-up, two aspect fields (‘W’

Aspect Ratio:

Custom

® See how we carefully avoid using the word ‘crop’ here? And how we equally refrain from using the word
‘butcher’?



and ‘H’), and a “flip’ button that turns the aspect ratio by 90° (or rather, simply exchanges
the values in W and H).

Using ‘Any’ Aspect
This is the default setting. You can change the crop area as you like it. While you

change the crop area, the crop table continually updates the aspect fields (called ‘W’ for
‘Width’ and ‘H’ for ‘Height’ of the aspect area) with current data.

When you are using ‘Any’ aspect, the “Turn Aspect’ button is inactive.

Using an Aspect Preset

If you choose any of the Aspect presets (from ‘Square’ to ‘TV, DVD’), the crop area is
automatically restricted to a shape that fits that aspect ratio. If you resize the area, the
crop table automatically adjusts the area to fit the aspect ratio.

Using Absolute Size

On some (very rare) occasion, a user requires a 100% crop (i.e. source pixel) of a
source image. Our crop table does this when you choose this setting. The width and
height of the crop are locked in (as defined by the W and H fields below the pop-up), and
the crop area cannot be resized, just moved. When cf/x photo exports, the resulting
image is a 1:1 copy of the source pixels.

Using a Custom Aspect

Instead of using a preset, you can define your own aspect ratio. If, for example you need
a crop that fits into a 2.8 by 6.9 cm field, simply enter these numbers into the W and H
fields. The crop table now enforces this aspect ratio for the crop area.

As soon as you enter a number into the W and H fields, the crop preset changes from
‘Any’ to ‘Custom’ to save you one full mouse click®!

Using a Custom Aspect with Fixed Output Size (‘Defined by Output’)

The crop table has built-in functionality for all artists that require fixed output size
(usually web artists and designers). This setting works just like a ‘Custom’ preset, except
that during export, cf/x photo automatically resizes the output to be exactly W pixels
wide, and H pixels tall.

o Projections based on industry numbers show that this feature alone can save you as much as 1.92
minutes (or 115.2 seconds) per month!



Tuning the current Aspect Ratio by 90°

At any time (except when using ‘Any’ and ‘Square’), you can flip the crop area by 90
degrees by clicking on the “Turn Aspect by 90°’ button.

Color Schemes

Depending on the image you want to crop, contrast between the cropped and kept areas
may not be sufficient for efficient work, or you may simply not like the way cropped-out
parts are colored. For this reason, the crop table offers you three color schemes to work
with:

Figure 6 : color schemes: Dark (left), Bright (middle), Red (right).

- Dark
Areas outside the crop are darkened, and white contrast hairlines lines mark
upper, lower, left and right sides. This is the default.

- Bright
Areas outside the crop are brightened, and black contrast hairlines mark upper,
lower, left and right sides. Works best with dark images.

-  Red
Areas outside the crop are tinted red. Black hairlines to mark upper, lower, left
and right sides. Works best with highly dynamic images.



Aligning your image

The crop table comes with an alignment utility that allows you to rotate your image +/- 23
degrees (a range of some 45 degrees). Use this function to correctly align horizontal or
vertical lines in your image.

To enable rotation, you first click on the ‘Enable
Rotation’ button next to the rotation slider. When
rotation is enabled (the button lights up red), you o -6
can use the slider (or a rotation gesture on your

trackpad) to rotate the image. In order to better
align your image, the crop table superimposes a yellow grid on your image

Rotation:

8 06 _MG_2610.jpg

) ® [ © o T og= ) =

Get Image Export Clipboard Preview Turn Left Turn Right Mirror H Mirror V. Print

11111

Note that the crop table allows you to include areas ‘outside’ of the image into your crop.
When exporting, these areas become transparent (if you export to a format that supports
transparency like, e.g. PNG).

Note also that you can change the crop area while rotation is active.



Pro Tools : Margins / Passe partout

Advanced users and professionals sometime need additional fine control over their crop
when they need to match a frame and paper size. Professional frames usually come
with a ‘pass partout’ cut-out. If you are using a frame with a pass partout, you want to
see the margin (parts that are outside), and be able to compose only the area that is
visible inside the cut-out.

cf/x photo supports passe partout — even if paper and pass-partout have different aspect
ratio.

To gain access to Margin/Pass partout controls, you must first choose ‘Toggle Pro
Options’ from the ‘View’ menu. The margin controls are normally hidden as not to
clutter the crop interface.
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Image:
Source: 1456x2184

Crop: 1368x1935
Aspect: 1.41 I1SO 216, DIN Ax

Rotation:
o - . - .

Aspect Ratio:
w: H
@ Turn Aspect by 90°

Guides:

off -+ .:--)( -Q

Color Scheme:

O NS

'Passe-partout' inner Margin

@ Use Inner Margin

Margin Aspect:

W: H:
L ]

Margin Size

Using 42.0 x 59.4 size, passe partout
region is 30.0 x 44.0

Figure 7 : 30x44 cm margins for a DIN A2 crop



When you are using Margins it is important that
you now the exact dimensions of the paper you 'Passe-partout' inner Margin
are printing on and the size of the pass partout
cutout. You are cropping for output size, and
are composing for the cut-out.

@ Use Inner Margin

Margin Aspect:

w: Bl + EEE

To correctly use margins, you should o

* enter the paper size into the Aspect
Controls. Using 42.0 x 59.4 size, passe partout

* Enable ‘Use Inner Margins’ region is 30.0 x 44.0

* Enter the cut-outs aspect (use the
dimensions you measured)

* Since cf/x photo allows for arbitrary and different aspects of crop and margin, you
must use the use the ‘Margin Size’ slider to match the margin size displayed
below the slider to the one desired.

Margin Size

In the example above, we wanted to compose the image for a 30 x 44 cm passe partout
that was to be printed on a DIN A2 (42.0 x 59.4 cm) paper. We chose ‘DIN A2’ from the
quick presets (which automatically entered the

correct values 42.0 and 59.4 into the Aspect’s W
and H fields. We were just lazy, and could have DIN A2 (42.0 x 59.4 cm)

entered those values manually. W: H:

Aspect Ratio:

Then we entered 30.0 and 44.0 (the size of the pass partout cut-out) into the Margin
Aspect fields. Looking at the resulting text below the slider we moved the slider until the
calculated cut-out matched the 30.0 by 44.0 we needed®

Note that as soon as you turn on margins, the composition guides will re-format
themselves automatically for the area inside the margin cut-out.

When margins are enabled they are visible on all worktables, but can only be modified
from the crop table.

' The reason why cf/x photo doesn’t automatically match margin aspect with paper aspect is simple: cf/x
photo allows for arbitrary, non-matching aspects for both margin and crop. 'Hard-wiring’ a conversion rate
would remove your ability to manually adjust the margin when you are not passe partout-bound.
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Image:
Source: 1456x2184

Crop: 1368x1935
Aspect: 1.41 I1SO 216, DIN Ax

Rotation:
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Aspect Ratio:

W: : B
@ Turn Aspect by 90°

Guides:
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Color Scheme:

O HEEETD

'Passe-partout' inner Margin
@ Use Inner Margin
Margin Aspect
w: |
]
Margin Size

Using 42.0 x 59.4 size, passe partout
region is 30.0 x 44.0

Figure 8 : 30x44 cm margins for a DIN A2 crop, fibonacci golden rule guides
active. Note that the composition guide is inside the
margin’s cut-out.

When you define the aspect ratio for the margin, try to use the same units as you used
for the crop aspect. If you inadvertently mix cm and inches, for example, the aspects
will still be correct, but you’ll have difficulties judging the correct margin size.




Effects and Color Control

The Effects and Color Control table in cf/x photo is a special treat. Instead of a few
simple one-trick ponies, this worktable allows you to combine any number of effects into
your very own toolbox, adjust them in real-time, change their order, and remove them.

There are two classes of effect that this table offers: color control (to subtly enhance
color and tweak the general appearance of your image), and special effects (that can
radically change the appearance of the whole photo.

To get to the Effects worktable choose the ‘f/x’ icon in the worktable selector:
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Photo Processing Worktable

Figure 9 : activating the effects work table

When you switch to the effects worktable, the table that you were using before switches
out, and the effects table switches in. If you came from the crop table, you’ll notice that
instead of showing the whole photo, the table has loaded the result from the crop table.
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Figure 10 : a typical f/x worktable with ‘Color Curves’ f/x loaded



To verify that you are really now using the effects table, check the lower right corner of
your window. It now should read ‘F/X Control’.

Just like before, the crop table is divided into a workspace on the left (where you can see
the result), and a black ‘Control’ area. This table uses only the control area, and is quite
simple to use.

Adding Effects

On the top of the control area there are four groups
of effects (called ‘Cool, ‘Kick’, “Tweak’ and ‘Sets’)
that you can add to your image.

To add an effect, just select one from one of the
groups. As soon as you choose an effect, that effect’s control panel slides in from the
right side. Use the controls on the panel to configure the effect.

If you already have one or more effects active on
your image, the new effect is added to the bottom
of the stack. This means that it will be applied
after all the other effects that you are already
using.

+
Color Curves

If there isn’t enough space to show all effects, the
effects control panel becomes scrollable.

Removing Effects

Note the small circled ‘X’ in every effect’s control
panel. Clicking into this X tells the worktable that

you want to remove the effect from the stack. o
not used
H
Changing Effect Order not used

Note the small up- and down-pointing triangles at
the bottom right corner of the effects control
panel. Clicking them will cause the table to move
this effect up or down the current effect stack.
Note that with most effects the order in which they Curve

are stacked is relevant, and reversing their order (] Tall s
can produce significantly different results. Use this
to your advantage when you build your ‘signatory
look’.

Deepness Shift

Brightness Shift




Resetting Effects

At the lower left corner is a reset button that lights up if you mouse over it. If you click it,
the effect reverts to its ‘Factory Standard’.

Effect Editing Limitations

Some special effects rely on certain geometric or other spatial properties of the photo.
Under certain conditions the export of such an effect can differ from what you see on the
worktable. The differences are usually small, but under adverse conditions can become
noticeable.

The effects worktable uses two different ways to warn you that this situation may arise:

If an effect may potentially have different results, it eIt
displays a small yellow warning triangle at the :

bottom of its control pane. The ‘Confetti’ effect Horizontal Shift
(control panel pictured right) belongs to this group. *
Notice the small alert triangle: Vertical Shift

Note that even though an effect may be producing different output, this does not
necessarily mean that it does. Only when the table detects that the result will look
differently (even if only marginally), it uses another, less subtle, way to warn you:

If you are using at least one effect that does cause visible differences
between the worktable and output (even if these differences are small), the
worktable places a large yellow ‘Attention’ mark in the upper left corner.

If you see this warning, we advise you that you use the ‘Preview’ button on

the toolbar. This causes cf/x photo to instantly create a full-quality export, and load it into
Apple’s Preview.app. Here you can decide if the differences are acceptable, or if you
should try a different approach.

Of course, should you ever forget what these warnings are for, you can click on them for
a gentle reminder.



Putting A Frame Around Your Photo

This worktable packages a lot of style into a deceptively simple interface. The object of
this table is to put a frame around your photo. Not all photos require a frame, as many
look perfect without them. But frames are a great tool to introduce some contrast, or
(especially if you put them into a web context) help to delineate the image.

They are, unfortunately, also a good way to completely butcher your otherwise beautiful
image. To prevent this, this worktable only offers you a small set of understated, but
definitely butcher-proof frames to choose from.

Go to the Frame worktable by choosing the frame icon in the worktable selector:
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Figure 11 : changing to the frame worktable

As usual, you can verify that you have changed to the correct table by looking at the
lower right corner of the window. The caption should read ‘Frame Control’.

When you work on the frame table, the result of the crop and effects table are
automatically integrated in your picture.

You can choose a frame family from the pop-up

in the Control section. Depending upon which Stylish Two-Color Frame

frame family you select, that frame’s control : o ‘ '
panel switches in. Unlike with effects, you can Outer Size
only have one frame family active at any time. — '
When you switch to a different frame family, Gap Size
however, the worktable remembers the settings e | '
of the frame family that is switched out, so you Inner Size

can easily switch back and forth between frame Outer/Inner Color
families to see what you like best. -

Tips for using Frames

- Use simple, neutral colors as frame color. White and black are your prime
candidates.

- Another good color choice for the frame is using colors from the image itself (use
the color pickup tool from the color manager for this).



Frame Families
Currently, the frame table supports the following frame families:

Description
None
No frame is drawn around the image.

Simple One Color
A frame of variable witdh. You can control frame size (width) and
color (here we use black).

Stylish One Color

The picture us surrounded by two frames of the same color, with a
transparent gap in-between.

You can control outer frame width, inner frame width, and gap size,
as well as the frame’s color (black used in this sample).

Simple Two Color

The frame consists of an inner and outer frame that have individual
colors. You can also independently set each frame’s color (black
and white used in sample). There is no gap between the inner and
outer frame

Stylish Two Color

Like the Stylish Once Color, except that the gap is now filled with a
second color that you can define. This sample uses black for outer
and inner frame, and white in-between, and the inner frame is
made to be the same size as the outer.




Adding Text To Your Photo

cf/x photo allows you to put text on your photo. Use this worktable to do so. You switch
to the text worktable by choosing the Text symbol (‘T’) from the worktable selector:
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Figure 12 : text worktable activated

When the text worktable switches in, you'll see that it incorporates the results of all
previous worktables: Crop, Effects, and Frame (the inclusion of the last table is of
particular importance as this allows you to place text onto the frame itself).

Because most photos do not require any text, this table has a ‘Master Switch’ that
completely switches off text addition — even if you have text defined. This way you can
preserve any text you have defined.

To use text, make sure that you click into the

Enable Text
‘Enable Text’ checkbox. £ Enable Tex

Text Opacity Control
Upper Text

Text Worktable Layout

To make text editing easy and effective, this Middle Text
worktable divides your photo into three separate ‘
text editors: Upper, Middle, Bottom.

Bottom Text

You enter and edit text simply by clicking into
any of the three boxes — just like you would with
any other text editor. Use the Font And Color Panels to change text color, text font, and
text size. You can change the text justification from the ‘Format’ menu.

Controlling Text Opacity

One unique attribute of this worktable is that it allows you to control the transparency of
the text for each of the three editors independently. Use the Text Opacity Control sliders
to do that.

The sliders are only visible if you enable text (i.e. put a check mark in the ‘Enable Text’
box’.
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You can enter any text in the three text
panes to the left. To use text, you must

_— H enable it first. Each text pane (upper,
use any text color, Font = Helvetica middle, bottom) has  separate opacity
control.

&4 Enable Text
Text Opacity Control

Justification = center
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Editor THREE

Figure 13 : showing off the text capabilities of the three
text editors. The Middle editor is set to 50% opacity.

Special Considerations

This worktable does not accept image drops. Instead, it converts all non-text drops into
the URL for the dropped object.



Applying A Copyright Notice / Watermark

‘Give credit where credit is due.” Unfortunately, sometime people don’t know whom to
credit. If you have a nice photo and want to ensure that it can be easily attributed to you,
you need a way to put your contact information (e.g. a watermark or logo) onto an
image. Photographers need to watermark preview image so their clients have an easy
way to connect the image to the artist. Models use a similar approach (although they
prefer SED-cards that you can create much easier with cf/x alpha'").

Web sites love to watermark their images for mysterious reasons’?. And if you work in a
big company we hear that project logos are le dernier cri'® and can be found on all major
presentations.

So if you find yourself in need of watermarking or Cl-branding your photo, cf/x photo
comes with a whole table dedicated to this task.

You switch to the Copyright/Watermark table by clicking on the ‘©’ Icon:
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Figure 14 : copyright / watermark worktable active.

When the copyright/watermark table switches in, it integrates the result from the crop,
effects, frame, and text table.

Logo and Watermark

This worktable provides you with two independent tools: a logo manager and a
watermark manager. Both managers work similar. You can choose to use one, both or
none (none is the default).

Logo

A ‘logo’ in this context is any image file you like'*. The table fully supports images with
transparency (in fact, we believe that most logos utilize transparency). The initial ‘Big
Logo Company’ image is just a placeholder we provide to show off this fact.

"' No, we are never above honking our own horn.

'2 We assume it has to do with attribution. But honestly, most images are so bad that we would
recommend they watermark them ‘not created by us’.

'3 Perhaps the thinking is that a nice project logo distracts from a terminally boring presentation.
Unfortunately, most project logos match the presentation.

' This means that you can also use this function to compose one image into another — yes we do realize
that there are smart people out there who will abuse our software in unpredictable ways. This is not one of
them.



Watermark
A watermark in this context is a single line of text that may contain only standard glyphs

(‘© and ‘@’ are ok, ‘®’ isn’t).

If your line of text contains an illegal glyph, this may prevent the whole line of text from
showing up.

The watermark is always set in the ‘Helvetica’ font.

—
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Logo

Add your logo and copyright notice here.
The logo supports transparency. Use drag
& drop to drop any image into the logo
space below.

Message

Add your copyright message below. The
message is only a single line

Created 2011 by cf/x image labs
R

Size

Opacity
Message Opacity

& Add Contrast

Graziad 200 oy cilelmzgz laos)
’ e

Figure 15 : Logo and Watermark applied to an image.
Note that the contrast option for the white watermark is active.



Working with Logos

To use a logo, simply drag and drop an image onto the Logo rectangle (the one that
shows the ‘Big Logo Company’ Image). Most image file formats are supported.

Once you have defined a logo, you can use the following controls
- Size Slider:
This slider controls the size of the box that contains the logo. This box can never
be larger than the image it is applied to.

- Opacity Slider:
This slider controls the opacity/transparency of the logo. Note that if your logo has
transparent parts they remain completely transparent even if you set logo Opacity
to 100%.

- Placement:
To move the logo on the photo, simply click into the logo on the worktable, and
drag it around. Note that the logo must always remain completely on the surface
of the image.

Working with Watermarks

To watermark your image with text, simply type something into the ‘Message’ field. You
can change the message at any time. Once you have set a message, use the following
controls:
- Size Slider:
This slider controls the width of the message. The table then automatically
derives the correct font size. The text expands to completely fill the width you
specified.

- Opacity Slider:
This slider controls the opacity of the watermark.

- Message Color:
This controls the color of watermark (or rather: the letters that the watermark is

made from).

- Add Contrast:
This option, when enabled, ensures that a high-contrast second color is placed
beneath the watermark to ensure that the whole watermark is completely legible
even on highly dynamic photos.

- Placement:
To move the watermark, click into the watermark, and drag it around. Note that
the watermark must always remain completely on the image.



Adding Transparency to your Photo

A unique feature of cf/x photo is that it allows you to add transparency to your photos.
This feature is especially useful if you want to superimpose two photos or use the photo
as an illustration or on your web page.

To get to the transparency worktable, click on the ‘disappearing box’ icon'.
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Figure 16 : atactive ransparency worktable.

At the transparency table you can choose from a number of transparency families that
either create a transition (blend), or transformation (projection) of the picture. The result
always has the same dimensions as before, but part of the picture can become ‘empty’,
i.e. transparent.

Note that if the source image (i.e. the photo that brought in) already has transparency,
this table’s transparency is added to the existing. This can result in non-trivial, complex
transparency. Try it!

You can choose between the following transparency families:

Sample Description
Standard (completely opaque)
The picture is unchanged.

Fixed Transparency
The image has an even, universal transparency that you can
control. Example uses a transparency of 50%.

'* Yes, we know that to some people it looks like an open door. No, our interface artist did finish school,
thank you.
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Directional Blend

The image acquires a directional (linear) transition between two
opacity values. Example shows a transition from fully transparent
to fully opaque, at an angle of 45°.

Dual Directional Blend

This creates two directional (linear) transitions between two opacity
values, back-to-back.

The Example shows a transition from fully transparent to fully
opaque, and back to transparent, at an angle of 45°.

Oval (Radial)

This creates a transition from a center outward.

Example shows a transition from fully opaque at the center to fully
transparent. Center of transition is put on the model’s eye, and the
transition is a circle (1:1 aspect).

Perspective project

This rather unique transformation allows you to ‘stretch’ your photo
from four different corners. The surrounding ‘free’ areas
automatically become fully transparent.

Transparent Frame

This allows you to surround your picture by an invisible frame
(useful if you are assembling images in a grid), of semi-transparent
frame.

If you add transparency to your photo, be sure that you export to a file format that
supports it (e.g. PNG, PDF). If the chosen export format does not support transparency,
transparent parts appear dark, or even black.




Saving your own Presets

You can save your own presets simply by choosing ‘Save’ from the file menu. CF/X.
cf/x photo then saves all your settings (crop, f/x, frame, text, copyright, blend)

into a ‘.photo’ document (that only photo can read). It also saves a copy of %
the current image with the file so you have a reference for all settings the PHOTO
next time you open this document.

Once saved, you can easily recall these settings by either choosing ‘Open...’ from the
file menu, or by double-clicking on the ‘.photo’ document.



Exporting your photo

You can export (save) at any time to many different targets:
- Clipboard
- File (photo crop supports most common file formats)
- Mail
- Preview App
- iPhoto
- Aperture
- Desktop Image
- Flickr (a social website)

Export to File

Unless explicitly told to do so, cf/x photo does not overwrite the source file. When you
save the crop as a file, cf/x photo appends a ‘-proc'® to the file name and then allows
you to save the new crop anywhere you like.

When you export to file, you can choose the file format irrespective of the source format.
Choose the file format that suits your needs best. To export, click on the ‘Export’ icon in
the tool bar, or choose or ‘Export (Share)’ from the ‘File’ menu. cf/x photo responds with
a dialog that shows a small preview, and allows you to select the file format

Type : Color Image, sRGB, 24 bit

Croped Size: 1099 x825
Aspect Ratio: 1.33 4:3 - TV, XCA

Export Cropped Image To:
Desktop ﬂ

Figure 17 : export dialog

cf/x photo always exports the finished product, regardless which table you call the
export function from. This means that the export always includes all processing from
the crop, f/x, frame, text, copyright and transition tables.

'® To indicated that this file was processed



You can choose any of the following file formats:

File format Compression Transparency
JPEG Lossy NO
TIFF Lossless YES
PNG Lossless YES
PDF Yes Limited
Macintosh PICT"’ Lossless NO
Windows BMP Lossless No
PSD Lossless, single layer YES

only
GIF'® Lossless, 256 colors YES, 1 Bit
JPEG 2000 Lossy YES
iPhoto'® Lossless YES
Aperture® Lossless YES
Desktop Lossless YES®!
Clipboard Lossless YES
eMail Lossless YES

Note that cf/x photo remembers your file format choice.

Export to Clipboard

This is essentially the same as choosing ‘Copy’ from the Edit menu. A full-resolution (or
fixed-resolution if enabled) copy is put on the clipboard.

Export to iPhoto

cf/x photo can export directly to iPhoto. The photo appears in an Album called ‘cf/x
Exports’. If iPhoto is not running, it will be started during export.

Export to Aperture

cf/x photo can export directly to Aperture. The photo appears in an Album called ‘cf/x
Exports’. If Aperture is not running, it will be started during export.

' No longer supported in OSX 10.6 ‘Snow Leopard’ or above

'® This ancient format only supports 256 colors or 255 plus one ‘Transparent’ color. Good for grayscale,
though.

"9 Will arrive in an Album called ‘cf/x Exports’

20 Will arrive in a Project called ‘cfx Exports’

2 Transparent parts will appear black. Unfortunately, it can’t make your monitor transparent.



Export to Preview.App

You can immediately export to Apple’s Preview.app. To export to Preview, click on the
‘Preview’ icon in the tool bar, choose ‘File>Export to App>Preview’, or hit the ‘P’ key.

Exporting To Mail

For your convenience, cf/x photo can directly export to email so you can send your
polished photo to your friends. Simply click the ‘Export’ icon on the toolbar, and choose
‘eMail’ as file format. cf/x photo creates the image, and hands it off to Apple Mail. You
can then edit the email from within Apple Mail.

cf/x photo’s mail integration works only with Apple Mail. If you are using a third party
mail app, this function does not work.

Upload to Flickr

cf/x photo can directly export your work to the ‘Flickr’ social website. In order to do so,
you must have a valid Flickr account, be connected to the Internet, and you must grant
cf/x photo the right to upload images.

To export to Flickr, simply click the ‘Export’ icon on the toolbar, and choose ‘Flickr’ as file
format.

Allowing photo to upload to Flickr

If you have not yet set up your Flickr account to work with cf/x photo, or if you have de-
authorized Flickr to accept content from cf/x photo, you are asked to authorize Flicker to
grant collage read and write (but not delete) privileges.

Set up Flickr account

Authorize cf/x photo crop for Flickr

cf/x photo crop can publish your crops to Flickr accounts. To do so,
you must authorize photo crop to access your Flickr account. If you
want photo crop to be able to access your flickr account, please press
the 'Setup’ button.

( Cancel ) ( SetUp )

Figure 18: Flickr account setup



Once the authorization request has been sent to Flickr, cf/x photo displays a dialog to
this effect, and will wait for you to grant access in your Browser.

Waiting for Flicker to authorize

Authorization Request Submitted.

cf/x photo crop has sent an authorization request to your Flickr
account. Please authorize cf/x photo crop to access your Flickr
account now. Once you have granted access (in the Web Browser),
please click 'Continue'. If you do not want cf/x photo crop to access
your account, click Cancel.

( Cancel ) (Continue)

Figure 19: Waiting for Flickr to authorize

Once this process is finished, you can upload to Flickr.

Uploading Images to Flickr
Before you can upload to Flickr, you can specify a few options as follows:

Publish to Flickr account

Publish to Flickr account with the following settings:

This will export your cropped image to your Flickr account into the
Photostream. The canvas size may be modified for optimal Flickr size.

Account: cfx software

Export Name: [gazing into a soul.jpg ]
Who can View: [You ﬂ
( ) ( ) i
(_ Change Account... ) ( Cancel ) ( Publish )

Figure 20: Flickr upload options



The options available are the same that you have when you administer your Flickr
account. For privacy reasons, the View option will default to “You’.

To re-authorize or to switch to a different user, click on the ‘Change Account’ button.

Images that are larger than 1024 pixels in any dimension are automatically scaled so
that the largest dimension is exactly 1024 pixels. This is to comply with Flickr’s image
size restrictions.

Once the image is uploaded to Flickr, cf/x photo launches your default browser and
opens the newly uploaded image in Flickr. Note that any image you upload will add a tag
‘cf/x’ and a description of ‘Created with cf/x photo’. You can change that.



Overwriting the Original

cf/x photo provides a special command that allows you to overwrite the source file with
whatever you currently have defined as output. This is useful for workflow setups where
the images you are working on are already copies, or where you do not need access to
the originals any more.

Overwriting the original irrevocably destroys the original, and replaces it with your new
version.

To do so, choose ‘Overwrite Original’ from the ‘File’ menu. Since this is a potentially
dangerous operation, photo will ask you if you are really, absolutely, 100% sure that you
want to destroy the original.

Overwrite Original
You are about to overwrite the original of the image,
and will thereby DESTROY it. If you proceed, you can

not undo this operation. If you are sure, please click
on "Proceed & Destroy".

Proceed & Destroy ) ( Cancel )

If you decide to overwrite the original, cf/x photo first re-writes the file, and then re-loads
the image.



Using cf/x photo as a ‘cookie-cutter’

You can use cf/x photo not only to touch up individual images, but to quickly process
multiple images the same way. There are two ways to do this. On is using the fully
automated ‘Factory’ table, which is intended as a heavy-lifting solution for studios and
covered elsewhere in this documentation®

The lightweight, manual version of the Factory is almost as powerful, and only involves
marginally more interaction.

Here’s how you use cf/x photo to quickly apply the same setting to multiple images:

1. Start cf/x photo, and process the first image, just like you always would. Finally,
export and verify that everything is as you want

2. Optionally: save the current document so you can easily recall the settings

3. Get a new image into the currently open document (using drag & drop, by using
the ‘Get Photo’ button from the toolbar, or ‘Import Image’ from the file menu

4. Directly export the image. The exact same settings used for the original image are
applied to the new photo

5. Repeat 3 & 4 until all images are processed.

2 if at all — the Factory was not ready for release at the point of this writing
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Included Software Frameworks
cf/x photo crop uses the following software packages

* Sparkle, Copyright © 2006 by Andy Matuschak

“Permission is hereby granted, free of charge, to any person
obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the
Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute,
sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so,
subject to the following conditions:

The above copyright notice and this permission notice shall
be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY
KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE."”

If you purchased cf/x mosaic from the Apple Store, Sparkle is not part of the distribution
package.

* HDCrashReporter, Copyright © 2006 Humble Daisy

“This library is free software; you can redistribute it
and/or modify it under the terms of the GNU Lesser General
Public License as published by the Free Software Foundation;
either version 2.1 of the License, or (at your option) any
later version.

This library is distributed in the hope that it will be
useful, but WITHOUT ANY WARRANTY; without even the implied
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR



PURPOSE. See the GNU Lesser General Public License for more
details.

You should have received a copy of the GNU Lesser General
Public License along with this library; if not, write to the
Free Software Foundation, Inc., 51 Franklin St, Fifth Floor,
Boston, MA 02110-1301, USA

For more information contact: developers@profcast.com”

Imagery

Digital Images: cf/x stock photography
Digital image processing : cf/x alpha, cf/x photo
Artwork: cf/x, cf/x logo designed by Iris Schwarz
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